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Introduction 

With this book you get the “must have” knowledge that you need to 
make an informed decision when assessing your INSIDER® trial as 
the CRM and office management solution for your business. The 
book, however, doesn’t stop there – it gradually introduces you to the 
key practical tasks you will need to perform once you have switched 
to the full version of INSIDER® so that you could enjoy smooth 
transition from the trial setting to your actual work environment. 
 

How to Use This Guide 
This guide is designed to familiarize you with your INSIDER® 
system and to help you get up to speed quickly with using INSIDER® 
in your real-life business. To make the most of this guide, read the 
topics in the order they are presented in the book and, at the same 
time, perform on your computer the procedures with the trial version 
of INSIDER®. Though the guide is designed to be read sequentially, 
you can also jump to a particular topic if your work requires you to do 
a particular task without delay. Just be sure to get back later to where 
you have been and cover what you have skipped. 
Of course, not all of the INSIDER® capabilities can be possibly 
discussed in a quick-start guide  like this. The purpose of this booklet 
is to give you a head-start, but that’s it. Therefore, most of the features 
listed in the Introduction to INSIDER® 2009 topic (and this list of 
capabilities is far from complete!) are given there for information 
purposes only and instructions are provided only for a few of them. 
For further information on how to perform certain tasks in 
INSIDER®, refer to the INSIDER® online help system. 
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How This Book Is Organized 
In Part I, Getting Started, we introduce INSIDER® and its 
capabilities, provide notes on how to set up and start the program, and 
examine its user interface and the way it operates.  
In Part II, Getting Up and Running, we tell you how to perform 
some basic everyday operations with INSIDER® like adding contacts, 
creating assignments, issuing invoices and so on. 
Part III, Getting Down to Business, is where we help you set up and 
customize your INSIDER® for actual business use and rid of the 
sample data that comes with the trial version. We also cover one 
advanced task here – how to use INSIDER® to create personalized 
mailings to your prospects and clients. 
 

Terminology and Formatting Conventions 

Throughout this guide, the words “computer” and “machine” are used 
interchangeably, as well the words “INSIDER®” and “the program.” 

Terminology note: 

• For the screen elements which have their name written on 
them, like “the View menu,” are indicated in this book by 
bold typeface.  

Formatting notes: 

• The screen elements that are named in this book but do not 
have their name written on them, are indicated by mere title 
capitalization and regular typeface, e.g. the Results panel. 
(That is, the pane has no name in the program, but we call it 
“Results pane” for the sake of clarity.) 

• User input is indicated by italicized typeface, e.g. “type in the 
product/service name, in our case, Behind the Neck.” 
(Meaning you must type Behind the Neck in the field in 
question.) 
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Sidebars Used in This Book 
Within the step-by-step instructions, some additional information is 
provided in the form of Warnings, Notes, and Tips. Here is what they 
look like and what they are about: 

WARNING: 

 
Note: 

 
Tip: 

 
 

A warning indicates an important piece of information which you need to now in 
order to avoid some critical mistakes that may prevent your INSIDER® system 
from functioning properly. 

A note indicates a piece of information that helps you avoid non-critical mistakes 
in you work with INSIDER®. 

A tip is a piece of useful information that helps you work with INSIDER® faster 
and more easily. 
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Part I 
Getting Started 

In This Part: 
• Introduction to INSIDER® - capabilities and features 
• How to install INSIDER® 
• A quick tour of INSIDER® 
• How to work with records  

 

Introduction to INSIDER® 2009 
INSIDER® is the leading integrated customer relationship 
management (CRM) and office management suite. It is one system for 
all departments and operations of your firm – management and 
administration, marketing, sales, finances. It integrates the data from 
those activities and departments making it easy to access, secure to 
store, and available for various kinds of analysis and reports.  
INSIDER® offers powerful customer and contact management to help 
you save time, improve sales and marketing, and deliver better 
customer service: organize and manage all your contact, prospect, and 
customer information in one place; track leads and opportunities 
throughout the sales cycle; easily create, personalize, and track direct 
marketing campaigns in-house; and centralize your project-related 
information so you can stay organized and monitor tasks with 
automated reminders. In addition to that, INSIDER® enables you to 
maintain a product database and to create offers from templates that 
draw information directly for that database. You can also issue 
invoices and generate various types of reports, both pre-defined and 
custom. 
INSIDER® helps you create, personalize, and track direct marketing 
campaigns in-house for more effective marketing: a detailed form lets 
you enter all the details needed for producing an effective campaigns 
filtering customer and prospect data enables you to produce targeted 
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mailing lists; INSIDER®’s mail merge capabilities allow you to 
personalize sales letters and marketing publications created in 
Microsoft Office Word; and, last but not least, you can track the 
response to your campaigns to determine their effectiveness. 
INSIDER® helps you manage prospects, leads, and clients from first 
contact through deal closing to customer retention so that you can 
communicate and sell more effectively. Tracking prospects and leads 
in INSIDER® is all-encompassing and efficient, it covers things like 
contact information, communications history, documents, sources, and 
probability of closing. With INSIDER®, you can view your 
opportunities by sales stage and probability of closing and track them 
from the initial contact to closing the sale.  
INSIDER® allows you to handle with ease both the external and 
internal aspects of the activities of your organization. External aspects 
are the aspects of an activity that are targeted towards the market – 
customer and prospect management (including full client details and 
history), marketing campaigns, offers, sales, etc.. Internal aspects are 
the organizational aspects of the activities and they concern your staff, 
their tasks, assignments, memos, etc. and the coordination of these 
activities among the members of the various teams and task forces. 
All these capabilities come on a flexible, largely customizable 
structural base, so you can adapt your copy of INSIDER® to suit your 
unique business needs: you can define your own custom categories 
and sub-categories of information, like assignment sub-tasks, 
company departments (for both your own firm and the clients’ 
companies), currencies, contact categories, and much more; you can 
even custom-label and use for your own purposes some of the fields in 
the contacts’ profiles. 
With INSIDER® you can: 

• maintain a complete contact database including a detailed 
client profile and client history of offers and purchases 

• manage all types of activities like meetings, phone calls, 
emails, custom tasks, etc., and relate them to individual client 
and leads profiles 
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• co-ordinate the tasks and activities of staff members through 

a visual calendar and by assigning responsibilities and 
issuing notifications; the assigned tasks appear automatically 
upon creation in the calendars of the concerned staff 
members 

• retrieve the needed information quickly and easily for 
practically all kinds of data (e.g. clients, sales, etc.) through 
the INSIDER®’s built-in sort and search capabilities 

• work with optimal productivity: INSIDER® has a logical 
interface that allows you to switch screens quickly; you can 
get back to the current contact profile with one click  only; 
you can automatically enter repeated or most frequent pieces 
of data in the records, and so on 

• maintain a comprehensive and neatly organized catalog of 
your products and services 

• fully manage your marketing campaigns, both 
organizationally and financially, including target groups 
definition and management, budgeting, assigning activities 
and responsibilities, attaching documents, etc. 

• create automatically personalized mailings using MS Word 

• generate group activities, related to a target group or 
campaign 

• analyze your marketing campaigns 

• have ready-to-use offers for any occasion by just selecting 
the appropriate introductory and ending texts from a list of 
existing templates  

• generate offers and invoices straight from the client’s profile 
and an invoice directly from the related offer 

• track payments and generate collection notices for overdue 
payments 

• track and analyze sales 
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• assign additional information in the form of files to certain 

types of data, like contacts, tasks, campaigns, which is an 
effective way to manage documents that are scattered around 
the network and making them available where they logically 
belong to; take your online collaboration with your 
colleagues to the next level by accessing documents from 
within INSIDER® 

• conveniently export information to MS Excel and MS Word 
and import your existing data 

• maintain your own custom types of contact information 

• perform quick analysis on any type of data in your system 
with ready-to-use analytics that take advantage of 
INSIDER®’s built-in business intelligence system (based on 
the advanced OLAP technology) and present the results 
visually in graphical charts 

• generate reports on various subjects (e.g. contacts, offers, 
tasks) with pre-defined templates or extend the reporting 
capabilities of INSIDER® even further with custom 
templates to fully meet your business’s unique needs 

• and most of this is as easy as selecting an option from a right-
click menu or performing a drag-and-drop with the mouse! 

 

Hardware and Software Requirements for 
INSIDER® 
Before installing INSIDER®, make sure your computer meets at least 
the minimum hardware and software requirements for running the 
program. The following table presents not only these requirements but 
also the recommended values: 
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Table 1 – Hardware requirements for installing INSIDER® 
Component Minimum Recommended 
Processor Type Pentium III 

or comparable 
higher than 
Pentium III 

or comparable  

Processor Speed 500 MHz 1 GHz and 
higher 

Memory Capacity 500 Mb 1 Gb and more 

Video 32-bit color, 
1240x760 

32-bit color, 
1280x1024 

Hard Disk Space  
(depends on the installed 
software components): 

  

     .NET Framework 2.0 280 Mb 1 Gb 
     SQL Server Express 600 Mb 600 Mb 
     INSIDER® Client 60 Mb 60 Mb 
     INSIDER® Server 6 Mb 6 Mb 
     INSIDER® Service 6 Mb 6 Mb 

 
As you can easily figure it out from the table, it would be a safe bet to 
install INSIDER® on a drive that has around 3 Gb of free space. 
The current version of INSIDER® is supported by the following 
operating systems (where service packs (SPs) are indicated, the higher 
versions of the SPs are supported as well): 

• Windows Vista 
• Windows Server 2003 SP1 
• Windows Server 2003 Enterprise Edition SP1 
• Windows Server 2003 Datacenter Edition SP1 
• Windows Small Business Server 2003 Standard Edition SP1 
• Windows Small Business Server 2003 Premium Edition SP1 
• Windows XP Professional SP2 
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• Windows XP Home Edition SP2 
• Windows XP Tablet Edition SP2 
• Windows XP Media Edition SP2 
• Windows 2000 Professional Edition SP4 
• Windows 2000 Server Edition SP4 
• Windows 2000 Advanced Edition SP4 
• Windows 2000 Datacenter Server Edition SP4 

 

Installing INSIDER® – Please Read BEFORE 
Starting Setup 
The INSIDER®’s setup process is quite straight-forward but requires 
some familiarity with networks and MS SQL Server. Yet, if you don’t 
have that kind of knowledge, the information provided in this topic 
should be sufficient to enable you to do the setup on your own.  
Once you start the setup from the demo CD or from the downloaded 
setup file, the setup wizard will guide you through the steps of the 
procedure. At some of the steps you will be given the option to change 
the default settings and custom-configure your INSIDER® 
installation.  
The default settings work fine for evaluation purposes and in some 
typical cases (for setup on a stand-alone computer or on a server 
machine), but depending on your real-life business needs, you might 
need to change these default settings to what is actually required in 
your particular situation. For this reason, if you are installing 
INSIDER® for real use and not for evaluation purposes, be sure to 
read this topic PRIOR to attempting the actual installation – it will 
help you avoid installation mistakes and, possibly, the need to reinstall 
the program. 
After choosing English as the language of the installation and after 
accepting the license agreement, the first point at which the 
installation wizards will ask you to make a decision is when the 
program folder is about to be set up: 
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The default setting is the INSIDER_2009 folder in your Windows’ 
Program Files folder, e.g. C:\Windows\Program Files\INSIDER_2009 if 
your Windows folder is C:\Windows. If this is the first time you are 
installing INSIDER®, the INSIDER_2009 folder does not exist and 
will be created during the setup process. You are free to change the 
program path to anything that suits your needs (e.g. a different drive, 
for example) by typing the desired path directly in the path field or by 
navigating to a desired location using the Browse… button. If you 
don’t have any particular reason to change the program folder, it is 
recommended to use default one. 
Next comes the Select Components step: 
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It enables you to choose which INSIDER® components you want to 
install. Several pre-configured choices are given in the drop-down list. 
For the purposes of this quick-start guide, let’s select Full 
Installation. (For a more detailed explanation of these setup options, 
as well as in case you are installing INSIDER® on a network, refer to 
“Customizing Your INSIDER® Installation” and “Using INSIDER® 
on a Network” (pages 51 and 54, respectively).) 
WARNING: 

Depending on the configuration options chosen, some additional setup 
programs (like MS Visual Studio 2005 Runtime setup) may run within 
the INSIDER® installation procedure and you will be required to 
accept the terms of their license agreements, too.  
In one of the next steps, ”Configuring Application Server”, the setup 
program will ask you to select an SQL Server from the list of the 
already installed SQL servers. If there hasn’t been any SQL servers 
installed, the server installed by the INSIDER® setup will be the only 
one listed and the window for this step will look like this (In your 
actual installation, instead of SUN you will see, of course, the name of 
your actual computer.): 

1. If you already have another edition of MS SQL Server 2005 (Workgroup, 
Standard, or Enterprise) installed on your computer, be sure to deselect

2. If setup finds an existing INSIDER® database, you will be provided with 
options to backup it and, if the database comes from an earlier version of 
INSIDER®, upgrade it. Backing up your database is a good precaution against 
incidental data loss. 

 the 
Microsoft SQL Server Express option. This is necessary because the SQL 
Server Express setup does not check for previous SQL Server installations and 
installing it over an existing SQL Server may cause problems. 
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Note that if the desired SQL Server has not been found, it can be 
entered manually in the lower field. Select or type in the server name 
and click the Next button to proceed. Once this step is complete, the 
same window will pop-up again but this time it will have Finish 
button and not Next. Click it to proceed to the next step. 
After the SQL Server setup, you will be prompted for the license for 
INSIDER®: 

 
To proceed, check the Use trial version box and click OK. 
Once the INSIDER® setup is complete, depending on the installed 
options, you may be asked to restart your computer, otherwise, on the 
last screen of the wizard, you will be provided two options which, if 
checked, will start INSIDER® immediately after the wizard closes: 
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Starting INSIDER® and Logging on for the First 
Time 
If you have made a standard INSIDER® installation, the INSIDER® 
icon ( ) should be available on both your desktop and the Quick 
Launch bar of the Taskbar. You can launch INSIDER® either from 
there or from the Windows’ Start menu. INSIDER® does not allow 
for unauthorized use, so whenever it starts, it first displays its login 
window requesting a user name and a password: 

 
The default user with which the evaluation version comes is admin. 
(This user has unrestricted access rights and permissions to the 
program so you can log in and set up your INSIDER® for actual use. 
Later you will create additional users with restricted rights for your 
employees to log in and work with the program). 
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The password for the default user is 123. (You will change it later to 
something more secure. Refer to “Changing the Administrator 
Password” on page 59.) Type it into the Password field. The default 
values in the Server and Port fields are OK for the currently installed 
configuration (Full Installation). Click OK. After a few seconds the 
INSIDER® window opens up. You are now logged in to the system as 
user admin. 
Note: 

 

Quitting INSIDER® 
Like most Windows applications, there are three ways to quit 
INSIDER®: 

• You can click the  button in the upper right of the 
INSIDER® window: 

 
• You can select the Exit option from the File menu: 

 

Every employee in the firm using INSIDER® should have an INSIDER® user 
account created for him/her (see “Creating New Users” on page 62) and should 
be able to access INSIDER® only with him/her own user name and password. 
This is necessary not just for security reasons but also to ensure the proper 
functioning of the INSIDER® system (e.g. each employee needs to see their own 
assignments and so on). 
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• You can use the Alt+F4 keyboard shortcut. 

 

Making Your Way Around 
INSIDER®’s interface is straightforward and easy to use. It will seem 
familiar to you if you have some experience with Microsoft Office 
Outlook. Similar to Outlook, INSIDER®  has a Navigation Pane on 
the left and, depending on what you select in it, the respective content 
is displayed in the right-hand side area (which is called “Information 
Display Pane”).  
 

Graphic Representation of INSIDER® User Interface 
Before proceeding any further, now is a good time to have a look at 
the INSIDER® window and its main parts. Take a minute or two to 
examine the illustration bellow and the reference table that follows in 
order to learn about the basic elements of the INSIDER® window, 
their function, and the terminology we use to refer them. 
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Title Bar: Displays the name of the software and, in square 
brackets, the name of the currently selected screen. 

 
Menus: The commands needed for your work are located in 
menus, such as File and View. Click the menu to display the 
command group. 

 
Toolbar: Frequently used commands are located here. 

 
Navigation Pane: Enables you to switch between the panels 
(Work, Marketing, Sales, Finance, Reports, and Settings) 
and select the screen you want to work in (e.g. in the Work 
screen group – Activities, Contacts, or Calendar.) 

 
Information Display Pane: Displays the content of the 
currently selected screen. 

 
Navigation Pane Buttons: Switch the view to display the 
related INSIDER® screen. 

 
Navigation Pane Panels: The panels in the Navigation pane 
group several screen buttons together. This grouping is 
logically based on the type of activities performed in the 
related screens. (For example, the Marketing panel contains 
the buttons for the Campaigns and Contact Groups 
screens.) 

 
Navigation Pane Panels Header: Clicking the header of a 
closed panel opens that panel to allow access to the screen 
buttons in it. 
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Tip:  

 
Navigating INSIDER® 
The Navigation Pane on the left-hand side of the INSIDER® window 
is always visible. You use it to navigate through INSIDER®’s 
screens. The Navigation Pane contains the screen-related buttons. 
Each screen-related button corresponds to a particular INSIDER® 
screen, e.g. Activities, Contacts, etc.. Clicking a screen button 
switches the INSIDER® view to display the related screen. The screen 

Take Advantage of Right-Click Menus 
Many tasks in INSIDER® can be performed from more than one screen and in 
more than one way. Generally, there are three ways to perform a task: from the 
menus, from the toolbar, and through a right-click menu. (All the three ways do 
not apply to all tasks but they do apply to most of them.) 
Right-click menus open when you click with the right mouse button on an object 
or on a blank space in the Information Display Pane, for instance when you click 
on an assignment record in the Activities screen. Right-click menus list the 
commands that make sense at the moment. In other words, right-click menus are 
sensitive to where you are and what you are presently doing, i.e. they are context-
sensitive.  

 
Because the right-click menus are easy to access and always offer valid choices, 
they are typically more convenient to use than the commands located in the 
standard menus above the program toolbar. So, here is a piece of practical advice: 
whenever you try to do something in INSIDER® for the first time, be sure to first 
check what commands are available in the right-click menu. Chances are that you 
will find the easiest way to perform a task right away! 
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buttons are arranged in groups, placed in individual panels (Work, 
Marketing, Sales, etc.) and only one panel can be opened at a time. 
To open a panel and access the buttons in it, click the panel header. 
Tip:  

 

Take a Tour of INSIDER® 
Now that you know how to navigate INSIDER®, let’s take a tour 
through its screens and find out what each screen is about and how it 
functions. (Click the corresponding button in the Navigation Pane to 
switch INSIDER® to the respective screen.) Refer to the table that 
follows for an overview of each screen. 

Panel Button Screen Explanation 
W

ork 

Activities Activities Enables you to view, create and manage 
activities. Activities are assignments of “to 
do” type that are assigned to and/or send 
employees. They can be related to a 
particular client (“contact”), can have a start 
date and end date, and can be displayed in 
the Calendar. There are six types of 
activities: Call, E-mail, Fax, Letter, 
Meeting, Task. Depending on the selected 
view, ether only Open activities are 
displayed (those that still need to be done) or 
both Open and Closed (completed or 
canceled) activities.  

Contacts Account This screen is like an address book but with 
some advanced capabilities. It enables you 
to create and manage the profiles of your 

Return to the Last Selected Contact Quickly 
If you have opened a contact profile in the Account screen and after that 
navigated to some other screen(s), you need not to go all the way through the 
Navigation Pane again to return to that profile. Just click the Active Contact 
button (whose label will be now displaying that contact’s name) on the menu and 
the contact’s profile will be displayed again: 
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Panel Button Screen Explanation 

firm’s contacts. A “contact” is usually an 
organization your firm is dealing with, like a 
client, prospective client (lead), partner, 
affiliate, but can also be a person – for 
example, a private client or an employee 
with your own firm. The individuals from 
the “contact” organization with whom you 
communicate are called “Contact Persons.” 

Calendar Calendar Displays a graphic calendar with the 
scheduled activities. There you can see your 
own activities (activities that are either 
created by you or assigned to you) and, 
depending on your INSIDER® user rights 
(typically if you are a manager), the tasks of 
the other employees. You can access 
activities and create new activities directly 
from the Calendar (that is, you need not to 
open the Activities screen to do this).  

M
arketing 

Campaigns Campaigns Enables you to create and manage your 
marketing campaigns. 

Target Groups Contact 
Groups 

Enables you to create and manage multiple 
target groups and sub-groups for your 
marketing activities and campaigns. 

Sales 

Offers Offers Enables you to create and manage the offers 
made to clients and prospects. 

Articles Articles/Items 
Catalogue 

In this screen, you maintain and manage 
your firm’s products and services.  

Finance Invoices Invoices Enables you to create and manage the 
invoices issued to clients. 

Reports OLAP OLAP OLAP stands for OnLine Analytical 
Processing – an advanced analytical and 
reporting technology with elements of 
artificial intelligence. This screen enables 
you to perform trend analysis on sales, 
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Panel Button Screen Explanation 

financial, and other information. It provides 
ready-to-use analytics and presents the 
results visually in graphical charts. 

Settings 

Users User Rights Enables you to set up INSIDER® users and 
manage their user roles (User or Manager) 
and access rights. 

System Data Nomen-
clatures 

Enables you to manage various system data 
categories and define their entries so you 
can adjust the way INSIDER® operates to 
your business model. Such system data 
categories are Activity Subtypes, 
Attachment Types, Contact Categories, 
Departments, etc. 

Data Import Data Import 
from Excel 
Sheets 

Enables you to import to INSIDER® data 
from your previous system or from other 
sources. The imported data must be in MS 
Excel 2003 spreadsheet format (.xls file). 

Report 
Configuration 

Report 
Configuration 

Enables you to upload pre-defined reports 
for use with INSIDER®. The uploaded 
reports must be in Crystal Reports for Visual 
Studio 2005 format (.xcr file). 

  
Tip:  

  

Sorting and Grouping Records 
As you have already noticed by now, quite often the information you 
are going to work with is presented in INSIDER® in table-like form 

INSIDER® Can Manage Additional Information 
INSIDER® not only can manage your assignments, contacts, and campaigns, but 
also enables you to add and manage some additional information related to the 
individual assignments, contacts, and campaigns by attaching files to them. This 
way you can keep all the information relevant to a particular assignment, contact, 
or campaign bound to that assignment/contact/campaign and readily available 
within a mouse click for you and for your colleagues to use. 
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in which the individual columns represent the various categories of 
information and the rows are the individual records. For example, in 
the Activities screen, each row represents an individual assignment: 

 
Under real-life conditions, your database can grow quickly to 
hundreds and thousands of records, so it is of paramount importance 
to be able to sort and group these records appropriately so you can 
have a meaningful and manageable view of the records. 
 

Sorting Records 
To sort the table by a particular category (column) in ascending order, 
click the column header: 

 
Clicking the column header for the second time, sorts the table by that 
column in descending order. 
 

Grouping Records 
INSIDER® has the fascinating ability to group the records that have 
the same content in the sort column and to present that grouping in a 
convenient tree-view form. Following is the Activities screen, but the 
records are now grouped:  
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To group the records presented in table-like form into a tree-view: 
1. Decide by the content of which column you want the records 

grouped. 
2. Drag with the mouse the header of that column to the blank area 

just above the header row. A successful drag is indicated by two 
red vertical arrows encompassing the blank area: 

 
3. Release the mouse button. The view of the panel changes from 

table-like form to a tree-view: 
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Each node of the tree represents the records that have identical 
value in the grouping category (column). (Each value existing in 
the column is now represented by an individual node.) The nodes 
are sorted by those values in ascending order. You can reverse the 
sort order by clicking the grouping column header (now located in 
the blank area). 

4. To view the records grouped under a node, click the plus sign to 
the left of the node: 

 
This will expand the node and display its records in table-like 
form (There will be a separate table for each node now):  

 
5. To restore the original table-like view of the panel, drag the 

header of the grouping column back to the header row. A 
successful drag is indicated by two red vertical arrows 
encompassing the header row: 
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Tip: 

 

You can group records by more than one column. To do this, just drag a second, 
third, etc. column header in the blank area. The order in which the grouping 
headers (the column headers in the blank area) are arranged determine the 
grouping order. (The records are grouped first by the content of the leftmost 
grouping header, then – by the one next to it to the right and so on.) You change 
the arrangement of the grouping headers by dragging them until you achieve the 
desired grouping order. 
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Part II   
Getting Up and Running 

In This Part: 
• Working with Contacts 
• Creating Assignments and using the Calendar 
• Adding Products and Services 
• Creating Offers for Clients 
• Issuing Invoices 

 

Working with Contacts 
Adding a New Contact  
1. Access the Account screen. To do this, either click the Active 

Contact button (see the tip in the Navigating INSIDER® topic) 
or, in the Navigation Pane, click the Work panel header if closed 
and then the Contacts button: 

 
This will display the Account screen with the last opened profile 
automatically shown onscreen. Your INSIDER® window should 
now look something like this: 
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2. Either press Ctrl + N or click the New button on the toolbar: 

 
This will get the Account screen cleared and the cursor blinking 
in the Name field indicating that INSIDER® is ready for your 
input. 

3. In the Name field, type the name of the contact’s organization, 
e.g. if it is a company, type the company name. 

4. Press the Tab key to move to the next field. 
5. In the same way, fill in all fields of the Contact General tab for 

which the respective information is available. Use the Tab and the 
Shift + Tab keys to navigate forwards and backwards through the 
fields or simply click with the mouse on the desired field. 
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Note: 

6. If the contact’s financial information is available, click the 
Contact Financial tab and enter the respective data there. 

7. Click the Contact Marketing and Contact Other tabs to see if 
the information to be stored there is available at the moment and 
if so, enter it, too. 

8. To add the contact person, in the middle panel of the screen, click 
the Persons tab: 

 
This will display the Persons tab in the upper panel of the screen. 
Your screen should now look like this: 

1. The Contact Person field will appear disabled. This is because you cannot 
enter the contact person name from this tab. Don’t worry about it, you will 
enter the contact person a few steps later. 

2. Some of the fields have drop-down lists and the entries can be selected from 
there if available; if not, just type the appropriate entry into the field. In the 
latter case, upon storing the new data (most likely in step 8), the program will 
ask you whether to add this new entry to the drop-down list so it would be 
available for selection from this point on. Confirm if you want the entry to be 
added to the list. 
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9. From the drop-down list of the Title field, select the contact 

person’s title (Mr., Ms., etc.). 
10. Press the Tab key to move to the First Name field. 
11. In the First Name field, type the name of the contact person’s 

first name. 
12. In the same way, fill in all fields of the Contact General tab for 

which the information is available. 
13. When finished entering data for that contact, either press Ctrl + S 

or click the Save button on the toolbar. 
14. (Optional) To switch the upper panel back to the Contacts 

General tab, click the Contacts button on the toolbar: 
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Finding Contacts 
In the Account screen (Navigation pane > Work panel > Contacts), 
you can perform searches to find a particular contact or a group of 
contacts that match your search criteria. You first switch the screen to 
Search mode, then enter your search criteria and perform the search. 
The search results are listed in the bottom (Results) panel of the 
screen. Here is a step-by-step description of the procedure: 
1. In the Account screen, click the Search Mode button on the 

toolbar: 

 
This will switch the screen to Search mode. You can tell the 
screen is now in Search mode because the color of the top panel 
has changed from blue to red. The top panel now serves as a filter 
form in which you are going to enter your search criteria 
(keywords). 

2. Enter your search criteria in the fields (Type them in or select 
them from drop-down lists where drop-down lists are available.). 
You can fill in as many fields as relevant to your search (Switch 
the tabs if necessary to use the fields in the other tabs.). For 
example, if you want to find all your clients located in Canada, 
select Client from the Category drop-down list and Canada from 
the Country drop-down list: 

 
3. Click the Find button on the toolbar: 

 
All matches found (your Canadian clients, in this example) will 
be listed in the results panel and their number indicated in the 
panel header: 
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Tip: 

 

Adding a New Assignment 
Adding a New Assignment from the Activities Screen 
Assignments are “action items”: things of “to do” kind, that is – pieces 
of work that need to be undertaken, like meetings, phone calls, 
mailings, etc.. Assignments in INSIDER® can have duration and 
deadlines and can be related to a particular campaign and/or client. 

If there are search criteria (keywords) you frequently use in certain fields, you 
can lock those fields so that they automatically display the criteria when you 
switch the screen to Search mode. To do this, when the particular keyword is 
displayed in the field (can be either typed in Search mode or just displayed in 
View mode, it doesn’t matter), click the field label (the name of the field located 
on its left). This will lock the content of the field as the default search keyword 
for this field which is indicated by changing the color of the label’s typeface to 
red. (If you want to unlock a locked field, click its label again.) 
This feature can come handy if you want to find contacts that are similar to the 
currently displayed one. Just lock the fields that should be displaying common 
content and perform your search. 
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Each assignment can have a person in charge appointed to it and can 
be distributed via your INSIDER® system to the 
colleagues/employees whom it may concern. (They will be able to see 
it in the Activities screen, as well as in the Calendar in most cases, 
when they log in to INSIDER® with their user names and passwords.)  
1. Access the Activities screen. To do this, in the Navigation Pane, 

click the Work panel header if closed and then the Activities 
button: 

 
This will display the Activities screen with the existing activities 
listed in it. Your INSIDER® window should now look something 
like this: 
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Note: 

 

Exactly which activities will be listed depends on the selected view filter. 
You can filter the tasks by user, e.g. to show either only your assignments 
(displaying the assignments either assigned to you or created by you) or the 
assignments of one or more users of your choice (can be all users, too). To 
filter the tasks by user, use the Users and My Activities buttons on the 
toolbar: 

 
You can also filter the assignments by status, meaning that you can choose 
to view either all assignments (both closed and open) or only the 
assignments that are open (still in progress) to date. To toggle assignments 
list open/all, select or de-select the Closed option in the View menu: 

 
When the Closed option is selected, the assignments with Closed status are 
visible and listed in red typeface in the assignments list.  
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Tip: 

2. Either press Ctrl + N or click the New button on the toolbar. 
This will bring on a form window with a form for creating a new 
assignment: 

 
3. In the form, the Type field has a drop-down list with the available 

assignment types.  
Note: 

For the purpose of this example, let’s stick to the default 
assignment type – Task. 

4. (Optional) If you don’t want this assignment to be shown in the 
Calendar, clear the Show in Calendar box. Otherwise, leave it 
checked (default). 

A new assignment remains bold until a user opens it. This way, when the 
screen is set to display the assignments of the other users, you are able to 
tell whether they have opened (and read) a particular assignment or not. 

The assignment types are hard-coded in INSIDER® and cannot be changed. 
Currently, INSIDER® offers the following assignment types: Call, E-mail, 
Fax, Letter, Meeting, and Task. The Task type has sub-types which are 
user-configurable. It is likely that the default task sub-types would be 
insufficient or wouldn’t serve you well in your actual business. You can 
change them and add new subtypes from Settings > System Data > System 
Data panel > Activity Subtypes option. 
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5. (Conditional – if Task type has been selected) From the Sub-

Type drop-down list, select the desired sub-type of the task, e.g. 
Research Assignment. 

6. Press the Tab key to move to the next field. 
7. In the Subject field, type a memorable name for the assignment, 

like Researching the independent gym owners in the South-East 
region. 

8. The Contact drop-down list is designed to indicate the contact 
whom the assignment concerns, which, especially for sales and 
marketing jobs, is normally a client or a prospective client. In our 
case, the assignment is a research job that will be performed co-
operatively with our firm’s marketing partner, so, from the drop-
down list, select Direct Marketing Systems: 

 
9. The Person drop-down list now lists the contact person(s) for the 

selected contact (as available in the contact’s profile). Click this 
drop-down list open and select the desired person: 

 
10. (Optional) If the assignment is related to a campaign, select it 

from the Campaign drop-down list: 

 
11. Assign the person(s) in charge for the assignment. To do so: 

a. Point and click the Responsible Persons button: 
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This will display the Select Users pop-up window for 
selecting one or more persons that will be in charge for the 
assignment: 

 
b. Click the plus signs next to the users groups to open the 

desired group(s) and then check the appropriate person(s) 
in it. 

c. When finished selecting users, click the Save and Close 
button. 

12. In the same manner, add the person(s) you want to receive a copy 
of the assignment (The assignment will be listed in their 
Activities screens when they log on to INSIDER®.). (Use the 
Copy to… button just beneath the Responsible Persons button.) 

13. In the frame, select the appropriate start date and end date for the 
assignment, as well as the starting and ending times, if applicable. 
(Opening the Start Date and End Date drop-down lists opens a 
calendar; clicking on the time in the same field highlights the 
hours and, respectively, the minutes and enables you to type the 
desired value.) 

14. In the big text field, click and type a description of the 
assignment. For example: Estimating the potential of the 
independent gym owners in the North-East and the cost of the 
initial market penetration.  
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15. (Optional) You can also attach to the assignment some 

documents that relate to it. Thus the users concerned will be able 
to access them without having to search for them on your firm’s 
document server or without the need to receive them by email. 
(To manage attachments, either use the Attachments menu or 
right-click on the attachments area at the bottom of the window.) 

16. When finished with creating the assignment, click the Save & 
Close button on the toolbar: 

 
This will close the window and list the assignment record in the 
Activities screen. In the same manner, the assignment is now 
available to all users that you have selected either as responsible 
for it (step 11) or as its recipients (step 12). The assignment will 
also be shown on the Calendar if the Show in Calendar box has 
been checked. If the assignment is related to a contact, the 
assignment will be listed in that contact’s profile (Account 
screen, middle panel, Activities tab). 

 

Adding a New Assignment from the Calendar 
You can use the very same procedure as described above to add a new 
assignment from the Calendar screen. (Just press Ctrl + N or click the 
New button.) 
 

Adding an Assignment Related to the Current Contact 
You can add an assignment related to the currently displayed contact 
directly from the Account screen (i.e. without having to go to 
Activities). To do so: 
1. Make sure the desired contact is currently displayed in the 

Account screen and, in the middle panel, the Activities tab is 
selected. The existing assignments related to this contact, if any, 
should be listed there. 
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Tip: 

2. Right click anywhere within the middle panel and, from the right-
click menu, select New Activity: 

 
This will bring on a window with a form for creating a new 
assignment; the contact’s name will be pre-selected in the 
Contact field. 

3. Proceed as described in “Adding a New Assignment from the 
Activities Screen”, step 3 and onwards. 

Tip: 

 

Navigating the Calendar 
You can navigate your INSIDER® Calendar in a few ways (To access 
the Calendar, in the Navigation pane, open the Work panel and then 
click the Calendar button): 

• Select the date you want to view by clicking it in the three-
month calendar display panel in the upper-right of the screen: 

The closed assignments will appear crossed-out. 

If you are in the Account screen and you need to create an assignment unrelated 
to the current contact, you can still do so without leaving the Account screen: in 
step 2, right-click not in the middle panel, but in the bottom panel (the Results 
panel) and, from the right-click menu, select Generate Activities. 
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• Choose a view by clicking one of the buttons on the toolbar: 

Day, Work Week, Week, and Month:  

 
• Filter the displayed tasks by user using the Users and My 

Activities buttons on the toolbar. 

• Toggle the view to display either all assignments or open 
assignments only with the Closed button on the toolbar.  

Adding a New Product or Service 
Adding a new product or service in INSIDER® is a two-step process: 
you first add all the details about the product except for its price and 
save your record. After that, you add the one or more prices for the 
product/service (INSIDER® allows for multiple prices per 
product/service) and save the record again. Here is the step-by-step 
description of the process: 
1. Access the Articles/Items Catalogue screen. To do this, in the 

Navigation Pane, click the Sales panel header if closed and then 
the Articles button: 
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This will display the Articles/Items Catalogue screen. In this 
screen, the products and services that correspond to the currently 
selected node in the Articles/Items Groups panel tree shown in 
the Articles/Items List panel at the bottom of the screen. The 
highlighted product in the list has its details displayed in the 
Article/Item Data panel above the list. Your INSIDER® window 
should now look something like this: 

 
2. Make sure in the Articles/Items Groups panel the top node, 

Articles/Items List, is selected.  
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Note: 

3. Either press Ctrl + N or click the New Item button on the toolbar. 
This will get the Article/Item Data panel cleared and the cursor 
blinking in the Code field indicating that INSIDER® is ready for 
your input. 

4. In the Code field, type the code for your new product, e.g. PC-
BN1. 
Tip: 

5. Press the Tab key to move to the Name field. 
6. In the Name field, type in the product/service name, in our case, 

Behind the Neck. 
7. Press the Tab key to move to the %VAT field. 
8. (Conditional) If the default VAT value indicated in the %VAT 

field differs from the value you want to use, type the desired 
value in the field, e.g. 20%. 

9. Press the Tab key to move to the Measure field. 
10. From the drop-down list of the Measure field, select pcs (pieces). 

Tip: 

When the Articles/Items List node is selected, all products and services are 
listed in the Articles/Items List panel; when a sub-node of the Groups  
node is selected, only the products/services that have been added to this 
node are shown in the Articles/Items List panel (The Groups node enables 
you to categorize and sub-categorize your products and services into groups 
of your choice as shown with the sample data.). 

Now a good time to develop a logical coding system for your products and 
services if you have no such system in place yet. A good coding system will 
make your product-related operations easier, especially if you have a lot of 
products. The sample database, for example, uses “P” to indicate a product, 
“S” – a service, “C” – for commercial equipment, and “H” – for home 
equipment, followed by hyphen and an acronym derived from the 
product/service name and a number to indicate the product version. The 
“PC-BN1” code used as an example in this step stands for “product which is 
a commercial piece of equipment and is named ‘Behind the Neck’ and its 
product version is ‘1’.” 

You can quickly move to the pcs value of the drop-down list by just typing 
p on your keyboard. 
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11. Press the Tab key twice

12. In the Description field, type a brief explanatory note about the 
product. In this example, as we are entering a piece of training 
equipment, the description could be something like this: StarFlex 
machine for exercising the latissimus dorsi muscle.  

 to skip the Inactive checkbox and move 
to the Description field. 

13. (Optional) Press the Tab key to move to the Notes field and type 
in some additional information about the product there, for 
example: Provides complete exercise for the largest muscle of the 
body. The Article/Item Data panel should now look exactly like 
this: 

 
14. Press Ctrl + S or click the Save Item button on the toolbar. 

Your new product/service record is now saved in the INSIDER® 
database, but you also need to add its price(s). 

15. On the toolbar, click the New Price button: 

 
A row for the new price record appears in the lower, Prices frame 
of the Article/Item Data panel: 

 
16. (Conditional) If you need to change the currency, do it from the 

drop-down list of the Currency cell of the row (the cell under the 
Currency header): 
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17. In the new row, click the Price cell: 

 
18. In the Price cell, type the desired value for the price, for example, 

1750. 
19. (Optional) If you want to add some explanatory text about this 

price, press the tab key to move to the Note cell and type the text 
in it. 

20. Press Ctrl + S or click the Save Item button on the toolbar. The 
price is now added to the product/service record. If you wish to 
add more prices for the product/service, simply repeat steps 
15÷20. 

Note: 

 
Tip: 

 

Creating an Offer for a Client 
1. Access the Offers screen. To do this, in the Navigation Pane, 

click the Sales panel header if closed and then the Offers button: 

If you have entered more than one prices for a product/service, make sure to 
indicate which one is the main price by checking the Base Price box for the 
respective price record. 

You can add additional prices at any time by clicking the New Price button. 



[43] 

 

 
This will display the Offers screen and list your existing offers. 
Your INSIDER® window should now look something like this: 

 
2. Either press Ctrl + N or click the New button on the toolbar. 

This will display the New Offer form window ready for your 
input: 
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3. From the Account drop-down list, select the client you are 

creating the offer for (The Account drop-down list displays the 
names of your contacts.): 

 
4. In the Valid till field just beneath the Account field, enter the 

deadline for the offer. The most handy way to do this is to use the 
field’s drop-down calendar: 
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5. In the middle portion of the Data tab, in the right-hand side table, 

open the drop-down list of the Article Code cell (the cell under 
the Article Code header) and select the desired product/service: 

 
Selecting an item from the drop-down list will cause the item’s 
name, description and unit of measure to appear automatically in 
their respective cells in the row. The table with the row filled 
should now look like this: 

 
6. (Optional) The default quantity for the added product/service is 1. 

If you want to change it, click in the Quantity cell and enter the 
desired value: 

 
7. Click in the next (blank) row to commit the entered data. 
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8. If you want to add another product/service, repeat steps 5÷7 in the 

new blank row in the table. You can add as many products as you 
want.  

9. Click the Texts tab to choose the text of the offer: 

 
10. From the Introduction drop-down list, select the introductory 

text: 

 
The selected text appears in the large text area beneath the 
Introduction field. 

11. (Optional) In the text area, edit and modify the text as needed. 
12. From the Conclusion drop-down list, select the closing text for 

the offer: 

 
The selected text appears in the large text area beneath the 
Conclusion field. 

13. (Optional) In the text area, edit and modify the text as needed. 
14. When finished making entries for the offer, either press Ctrl + S or 

click the Save button on the toolbar. 
15. (Optional) To see how the offer will look in print, click the Print 

Preview button on the toolbar: 
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This will display the print preview in a pop-up window. From 
here, proceed with either printing the offer or closing the window. 

16. To print out the offer, click the Print button on the toolbar: 

 
17. When finished working with the offer, close its window. This will 

take you back to the calling screen. 
Note: 

 
Tip: 

 

Creating an Invoice from an Offer 
To create an invoice from a particular offer: 

There is more to creating an offer than described here, like creating an offer with 
multiple options, assigning a different person in charge (by default it is the user 
who created the offer), recording the outcome after the offer has been made to the 
client and others, but explaining all options goes beyond the scope of this quick 
start guide. Please consult INSIDER® online help if in need for further details. 

You can also add an offer for the current contact from the Account screen: in the 
Account screen, select the Offers tab and then right-click anywhere in the tab 
beneath the column headers; after that, from the right-click menu, select New 
Offer: 

 
This will open the new offer form window with the current contact pre-selected 
in the Account field. 
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1. In the Offers screen, locate the record for the offer from which 

you want to create an invoice. 
Tip: 

2. Double click the offer record. This will open the offer in detailed 
view in a form window: 

 
3. In the toolbar of the window, click the Create Invoice button: 

 
This will display the New Invoice form window with the 
information from the offer automatically entered in the respective 
fields: 

You can also locate the offer by client in the Account screen, Offers tab. 
The procedure will work the same from there. 
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4. Enter and edit the data in the fields as necessary. Be sure to select 

the proper Document Type and Payment Type. 
5. When finished, press Ctrl + S or click the Save button and then 

close the window.  
 

Creating an Invoice from Scratch 
You can start the invoice creation process with a completely blank 
form. Use this procedure when you need to create an invoice that is 
not related to any particular offer recorded in INSIDER®. To create 
an invoice from scratch: 
1. In the Invoices screen (Navigation pane > Finance panel > 

Invoices), either press Ctrl + N or click the New button on the 
toolbar. 
This will display the New Invoice form window (see the last 
picture in the previous topic). 
Tip: 

You can also initiate the invoice creation process from the Account screen, 
Invoices tab. The procedure will work in the same way except that the 
current contact will be pre-selected in the Account field. 
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2. Enter the information in the fields as necessary. Be sure to select 

the proper Document Type and Payment Type. 
3. When finished, press Ctrl + S or click the Save button and then 

close the window.  
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Part III     
Getting Down to Business 

 
In This Part: 

• Customizing your INSIDER® 
• How to Create Personalized Mailings 
• How to Unlock the Full Version 
• How to Delete the Sample Data 

 

Customizing Your INSIDER® Installation 
As you already know, when INSIDER® is being installed, the Select 
Components step of the setup procedure offers you several sets of 
pre-selected component choices: 

 
Each of these pre-selected sets of components installs an INSIDER® 
configuration that is suitable for a particular purpose. The correct 
choice depends on the intended use of the machine on which you are 
installing INSIDER®: as an INSIDER® server, an INSIDER® client 
workstation, an INSIDER® server that is going to be used as a 
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workstation as well, or as a stand-alone machine without a network 
(See Table 2.). 
 
Table 2 - Pre-configured installation choices 

C
om

ponent 

Full 
Installation 
(default) 

C
lient-

O
nly 

Installation 

Full 
Installation  
(w

ith server) 

Service-
O

nly 
Installation 

Server-
O

nly 
Installation 

D
atabase-

O
nly 

Installation 

INSIDER 
Client       
INSIDER 
Service       
INSIDER 
Server       
INSIDER 
Database       
Microsoft 
Server 
SQL 
Express 

      
Microsoft 
NET 
Frame-
work 
(disabled if 
already 
installed) 

      
 
Here is which pre-configured choice you should select according to 
your needs: 
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Table 3 - Configuration choices and when to select each of them 
If this computer is… Select… 
the only machine with INSIDER® in your office Full 

Installation 
the INSIDER® server machine to which all other 
INSIDER® workstations are going to connect (this 
server machine will not be used as a workstation) 

Service-Only 
Installation 

the server machine to which all other INSIDER® 
workstations are going to connect and which will 
also be used as a workstation 

Full 
Installation  

an INSIDER® workstation (it connects to an 
INSIDER® server on another machine) 

Client-Only 
Installation 

a previously configured INSIDER® workstation on 
which you want to install a local database for 
training purposes 

Database-Only 
Installation 

Note: 

You can choose a pre-configured set (recommended), but you can also 
select and de-select individual components. (If you select individual 
components, and the selected options do not match any of the pre-
existing configurations, the configuration is marked as “Custom.”)  
 
WARNING: 

1. The Full-Installation (with server) and the Server-Only Installation are same as 
the Full-Installation and the Service-Only Installation, respectively, except 
that the former two do not run the INSIDER® server as a Windows service 
and, therefore, it does not start automatically with Windows and login to the 
server machine is always required in order to use INSIDER® on a network. 
The Full-Installation (with server) and the Server-Only Installation choices are 
included in the setup for legacy reasons and there is no benefit using them in a 
clean installation. It is recommended to use Full-Installation and Service-Only 
Installation instead. 

2. The INSIDER® sever can reside on a different machine than the SQL server. 

If you have selected individual components, make sure you have NOT selected 
both the INSIDER Server or the INSIDER Service option. Only one of them 
should be selected for the installation! (INSIDER Service recommended) 
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Using INSIDER® on a Network 
If you are logging in to a workstation computer (that is, a computer 
which connects to an INSIDER® server residing on another machine), 
make sure in the login window, Server field, the name of the server 
computer (illustration on the left) or its network IP address 
(illustration on the right) is listed (and not the standard localhost 
name): 

     
Note: 

 

Customizing the Navigation Pane 
Resizing the Navigation Pane 
You may want to reduce the width of the Navigation Pane so you can 
have more space (and see more data) in the Information Display Pane.  
To resize the Navigation Pane, point to the vertical splitter bar 
dividing the Navigation Pane and Information Display Pane. When the 
pointer turns into a double-headed arrow , drag the splitter left or 
right. If you drag the vertical splitter bar to the left (that is, towards the 
Navigation Pane), the Information Display Pane area will enlarge at 
the expense of the Navigation Pane. 

INSIDER® does not allow you to be logged in at the same time to two or more 
machines with the same user name. Therefore, when finishing your work with 
INSIDER®, make sure you exit the program so you could log in to another 
computer if necessary. Exiting the program after work is also a good practice 
from security point of view. 
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Changing the Display Order of the Navigation Pane 
Buttons 
You can rearrange the order of the buttons in any panel of the 
Navigation Pane – just drag the buttons with the mouse up and down 
until you achieve the desired order.  
 

Moving a Button from One Panel to Another 
You can move any Navigation Pane button from its original panel to 
any other panel of the Navigation Pane. This feature is mainly used 
for moving the most frequently used buttons to Work because it is the 
panel that opens by default when INSIDER® starts so you won’t need 
to go to the other panels anymore to access these buttons. Moving the 
Navigation Pane buttons in INSIDER® is a simple drag-and-drop 
operation: 
1. Click and open the panel containing the button you want to move. 

Let’s say, you work a lot with offers, so you would want to move 
the Offers button to the Work panel. 

2. Point with the mouse to the button and drag it over the header of 
the panel you want to move it to (Work in this case). Do not 
release the mouse button yet. 

3. Once the mouse pointer is properly positioned over the target 
panel header  (Work), release the mouse button. The button is 
now moved. 

4. (Optional) To verify the button is in its new location, click and 
open the respective panel header (Work in this case): 
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Tip: 

 

Adding Your Company Information 
Adding your company information to INSIDER® allows your 
company contact information to be displayed on the offers, reports, 
and invoices the program generates. This is done through the Owner 
Company option. When you first install INSIDER®, the owner-
company is set to the demo-company StarFlex and its fictitious 
contact information. You need to change it so you could start using 
INSIDER® for your actual business. (If the demo database has not 
been loaded, then the name of the owner company is INSIDER Owner 
and all other data fields for this company are blank.) To add your 
company info: 
1.  Make sure the Account screen is displayed (Navigation Pane > 

Work > Contacts). This will make the Open Owner option 
available in the File menu. 

2. From the File menu, select Open Owner: 

You may want to copy a button instead of moving it. Thus a button will be 
available in both its new and its original locations. To copy a button:  
In step 2, press an hold down the Ctrl key. A plus sign appears next to the mouse 
pointer. When you release the button in step 3, the button will be copied and not 
moved.  
Be careful when making the decision to copy a button – in the current version 
of INSIDER®, Navigation Pane buttons cannot be deleted, so a reckless use of 
this feature can clutter your Navigation Pane quite easily. 
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The owner company (that is, your company) record is displayed 
in the Account screen. 

3. Click the Name field and change it to your actual company 
name.  

4. Do the same with all other fields the information from which you 
want to be available (Phone 1, Phone 2, Fax, e-mail, etc.). Apart 
from your company name, no other fields are mandatory, but it is 
a good idea to have your company contact information as 
complete as possible. 
Note: 

5. (Conditional) If the VAT (Value-Added Tax) in your country 
differs from the default value, change that value, too (in the 
VAT% field). The newly entered value will become the new 
default VAT value. 

6. Click the Contact Financial tab and enter the appropriate data into 
its fields. 

7. When finished entering your data, click Save. 
 

Depending on the content of the database installed with INSIDER®, your 
Country, Region, and City might not exist in the drop-down lists of these 
fields. If this is the case, just type them into the fields manually and from 
this point on they will be added to the drop-down lists and will be available 
for selection. (When you attempt to save the data, the program will ask you 
whether to add these names to the lists. If you want them on the list, be sure 
to confirm.) 
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Adding Your Company Logo 
Adding your company logo to INSIDER® causes the logo to be 
displayed on the offers and invoices the program generates. To add 
your company logo: 
1.  Make sure the Account screen is displayed (Navigation Pane > 

Work > Contacts). This will make the Company Logo option 
available in the File menu. 

2. From the File menu, select Company Logo: 

 
In the dialog that opens, specify the path and the name of the 
image file with the logo: 

 
If necessary, use the Browse button to open the standard file open 
dialog for browsing for and finding the image file. 
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3. Make sure you have selected the correct image file (refer to the 

preview displayed in the lower half of the dialog) and then click 
Save.  

4. (Optional) To see how the logo will look on the documents 
generated by INSIDER®, click the Print button. This will display 
a print preview of the document.  

5. If necessary, edit the image with a graphics editing program and 
then re-load the logo (repeat steps 1÷4).  

6. When finished, click Exit. 
Note: 

 

Changing the Administrator Password 
The default administrator password, 123, is devised to be easy to use 
and remember so you can conveniently log in and explore all 
INSIDER® features during the trial period. Before entering any real 
data and beginning the actual business use of the program, it is 
mandatory to change the administrator password in order to ensure the 
security of your operations. The actual administrator password must 
be secure enough and known only to the person with the administrator 
role to INSIDER® and to the company owner. 

Tips for Creating a Secure Password 
When creating your INSIDER® administrator password, consider the 
following: 

• Long passwords are more secure than short ones. 
• Actual words from the vocabulary of a language, like those 

you can find in a dictionary, are less secure than arbitrary 
combinations of letters but easier to remember. 

1. The width of the logo image must be three times its height (that is width-to-
height ratio 3:1), otherwise your logo won’t display properly. 

2. If you chose to remove the logo (for example, when you estimate that your 
logo image would need some editing in order to display properly), simply 
check the no logo box and then click Save. 
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• Combinations of words, such as shinynail or flyingrock or 

tallwater, as well as combinations of words and numbers, 
like infinity101 make more secure passwords than single 
words. 

• Using both uppercase and lowercase letters in your 
passwords makes them more secure especially if you 
capitalize letters other than the first letter of a word, for 
example ShinyNail is more secure than shinynail, but 
shInynaIl is even better. 

• Using non-alphanumerical characters, like !@#$% greatly 
improves the security of your password. 

• Writing down a password on paper or in a file constitutes a 
security risk, though it may prevent problems with forgotten 
passwords. 

For practical purposes, probably the best approach for a password is to 
combine a one or two words with numbers and put them down on 
paper and keep that paper in a secure location. 
 

Steps for Changing a Password 
The following procedure can be used to change the password of any 
user, not just the administrator. To change the password of a user: 
1.  Access the User Rights screen. (In the Navigation Pane, click the 

Settings panel header to open it and then the Users button.) 
2. In the Groups panel, double-click the user whose password you 

want to change, e.g. if you want to change the password for the 
administrator, double-click the Admin (Administrator) node in 
the Users tree. 
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This will display the User Details window which stores the 
settings for the selected user. 

3. Open a plain text editor, such as Notepad. 
4. In the editor, type the desired new password. 
5. Select (highlight) the password and copy it to Windows clipboard 

(Ctrl + C). Make sure you have selected the entire password and 
not any white spaces next to it if such white spaces exist. 

6. Switch back to INSIDER®. 
7. With the mouse, drag and select all the asterisks in the Password 

field. All the asterisks should be now highlighted: 

 
8. Paste the new password (Ctrl + V). You will see the highlight 

gone and, probably, change in the number of the displayed 
asterisks (The number of characters in the field at this moment 
corresponds to the number of asterisks.) 

9. Click the Save & Close button. This will close the User Details 
window and apply the new password to the user. From this point 
on, this user will have to use his/her new password. 

10. Switch to the text editor again and either save or discard the file 
in which you have typed the password. If you choose to save it, 
make sure to store it in a secure location. 
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Note: 

 

Recovering Lost Passwords 
As a security precaution, passwords in INSIDER® cannot be 
recovered. If a user forgets his or her password, the administrator or 
another user with sufficient rights (typically with a Manager role in 
INSIDER®), can create a new password for him/her. In case no such 
user exists and the password for the Admin user is lost, then the only 
solution would be to uninstall INSIDER® while keeping the existing 
database (you will be offered this option at uninstall) and then install 
INSIDER® again without a database in order to prevent your database 
from being overwritten by the default one (make sure to clear the 
INSIDER Database option when selecting the options for setting up 
components). 
 

Creating New Users (New User Accounts) 
You should create an individual user for every one of your employees 
who are going to work with INSIDER®. To create a new user: 
1.  Access the User Rights screen (Navigation Pane > Settings panel 

> Users.).  
2. In the Groups panel, click and highlight the Users root node: 

You can type the password directly into the Password field and not use a text 
editor, thus skipping steps 3÷6 and 10, but this approach is prone to errors 
because, in the Password field, you cannot see what you type and INSIDER® 
does not require you to verify the new password. 
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3. Click the New button on the toolbar. This will display the User 

Details pop-up window containing the form for entering a new 
user: 

 
4. In the User Name field, type the INSIDER® user name for the 

employee, e.g. john. 
5. Press the Tab key to move to the Name field. 
6. In the Name field, type the actual name of the employee, e.g. 

John Smith. 
7. Press the Tab key to move to the Password field. 
8. In the Password field, type a password for the user. (Refer to 

“Tips for Creating a Secure Password” on page 59 if you need 
more guidance on this.) 

9. In the large area at the bottom of the window, check either the 
Users or Managers box depending on which of these two 
INSIDER® user groups you want the user to be assigned to. The 
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user group determines what INSIDER® user rights the employee 
will have in the system. 
Tip: 

10. Fill in the other fields of the form as necessary. 
11. When finished entering information in the fields, click the Save 

& Close button. 
Tips: 

 

Creating Personalized Mass Mailings 
Introduction 
With INSIDER®, you can easily create personalized mass mailings 
that you can send as email messages or printed letters to multiple 
recipients (for instance, a letter to your customers announcing a new 
product). To this end, INSIDER® utilizes the MS Word’s mail merge 
feature (INSIDER® provides the recipient information and Word – 
the text of the form letter), so you need to be familiar with mail merge 
in order to be able to use this feature with INSIDER®. (You can find 
the information you need to know about mail merge in the MS Word 
online help as well as in the other available MS Word user 
documentation.) Needless to say, you need to have both INSIDER® 
and MS Word installed and fully functional on the computer on which 
you intend to perform the mail merge procedure. Also, it is important 
to carefully read the instructions that follow because the INSIDER® 
version of mail merge has certain idiosyncrasies and you will not be 

The members of the Managers group have more rights than the members of 
the Users group. The main difference is that the Managers can see the 
assignments (in the Activities screen and in the Calendar) of the other 
users of the system while the Users can see only their own assignments 
(either created by them or assigned to them).  

1. You can set up the INSIDER® user rights individually for each user the right-
hand side panel. (Select the user’s node from the tree in the Groups panel and 
then edit the settings in the right-hand side panel.) 

2. You can create custom user groups to handle multiple users with common 
INSIDER® user rights if the pre-defined user groups (Managers and 
Employees) happen to be insufficient for your needs. 
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able to perform it if you follow only the standard instructions provided 
in the MS Word documentation.  
You use mail merge when you want to create a set of documents that 
are essentially the same but where each document contains unique 
elements (like the name and the address of the recipient). There are 
two pre-requisites to the mail merge procedure: a document, called 
“main document”, with the text to be sent as a letter and a data source 
for the variable information. In the main document, the places for the 
variable data (e.g. the recipient names, the salute, etc.) are occupied 
not by regular text but by special placeholders (fields) and the actual 
content is retrieved from the data source during the mail merge 
procedure. (That data source, in our case, is INSIDER®.)  
Before performing the mail merge, you need to have the main 
document created in MS Word and the fields for the variable data 
properly inserted in their respective positions. Once you have the main 
document ready, you start the mail merge procedure and Word creates 
the actual personalized letters, one for each recipient, in the form of 
either email messages, another MS Word document, or direct output 
to printer. 
When performing a mail merge with INSIDER®, the main document 
is generated automatically from an MS Word template (.dot file). This 
spares you the need to manually match the main document to the data 
source as you would mandatory have to when performing a “normal” 
mail merge outside INSIDER®. Therefore, with INSIDER®-based 
mail merge, you first create not a main document but a main 
document template
Note: 

 (Refer to the next section for details). 

 

INSIDER®-based mail merge works with both MS Word 2003 and MS Word 
2007. If MS Word 2007 is installed, it works in Compatibility Mode and creates 
the documents in MS Word 2003 format (.doc file name extension). 
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Creating the Main Document Template 
Introduction 
There are two types of fields that can be inserted in an MS Word 
document: standard Word fields, which are multi-functional and can 
be used for a variety of purposes, and specialized mail-merge fields, 
designed specifically for the needs of the mail merge feature. 
Normally (with the other data sources like MS Excel documents, text 
files, or MS Access) the variable data in the main document is 
represented and retrieved through mail merge fields. In the main 
document template however, the fields for the variable data must be 
Word fields and not mail merge fields

 

. This makes creating the main 
document a lot easier, as you need not to select a data source for the 
fields any more (Word fields allow for advanced programming and 
automation so INSIDER® can link the fields to its data source 
automatically when the mail merge procedure begins; in the main 
document that is generated automatically during the mail merge 
procedure, Word fields will be replaced by proper mail merge fields). 

Steps 
1. In MS Word, create or open the document you want to use as a 

main document template. 
2. (Conditional) Delete any text that is variable, i.e. any text that 

should be personalized, like the recipient name. 
3. Insert a Word field for any block of variable text. For information 

on what fields to insert for what data, refer to the Allowed Field 
Names for the Main Document Template topic.  
To insert a Word field: 

a. Place the blinking cursor at the position where the 
variable text should be inserted, e.g. by clicking on it. 

b. Press Ctrl + F9. An empty (unnamed) Word field is 
inserted. (The field is indicated by curly brackets – {}.) 
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c. Within the brackets, type the name of the field. (Refer to 

the Allowed Field Names for the Main Document 
Template topic.) 

4. When finished inserting fields, save the document as a Word 
template (.dot file). (Use Word’s “Save as…” feature.) 

 
Allowed Field Names for the Main Document Template 
The following table maps the names of the Word fields you can use in 
the main document template (left column) and the respective 
INSIDER® data field names as they appear onscreen (right column). 
(For example, if you want to insert the name of the contact person in 
the template (information that appears in INSIDER® in the Contact 
Person field), name your Word field Primary_Contact) 
Field Name – INSIDER® 
(all INSIDER® fields are from Account 
screen, Contact General tab) 

Field Name – Document 

Name Contact 

Contact Person (if more than one, the 
contact person marked as “Primary” will be 
used)  

Primary_Contact (note the 
underscore between the two 
words) 

Phone 1 Phone 

E-Mail Email 

Fax Fax 

Country Country 

Region Province 

City City 

ZIP ZIP 

Address Address 

Web Page WebURL 

Department Department 
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The Mail Merge Procedure 
Introduction 
You can perform mail merge to a list of selected contacts from either 
the Account screen or from the Contact Groups screen. Performing 
mail merge from the Contact Groups screen is preferable if the 
recipient group of your letter matches, entirely or partially, some of 
your target groups or sub-groups. If it doesn’t, either create a new 
target (sub-)group, or manually select the recipients from an existing 
group, or perform the mail merge from the Account screen using the 
search feature to filter the records so that the search results match the 
profile of the desired recipients as closely as possible. 
 
Performing Mail Merge from the Contact Groups Screen 
1. Access the Contact Groups screen. (In the Navigation Pane, 

click the Marketing panel header to open it if closed and then the 
Target Groups button.) 

2. In the Target Groups panel, from the groups’ tree, click and 
select the desired group or sub-group: 

 
The contacts that are members of this group will be displayed in 
the Results Panel in the lower-right area of the screen: 
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3. (Optional) Sort or group the records as necessary. (For details, 

refer to “Sorting and Grouping Records” on page 20.) 
4. In the Results Panel, select the contacts you want to include in the 

mailing: 
• left-clicking with the mouse selects and deselects 

individual records 

• Ctrl + left click selects a record and keeps the previously 
selected record(s) 

• Shift + left click selects a range of records and deselects 
any previously selected records outside that range 

• Ctrl + Shift + left click selects a range of records while 
keeping any previously selected records outside that 
range 

• Ctrl + A selects all listed records 
The selected records become highlighted: 

 
5. Right-click on the selection and from the right-click menu that 

appears, select Mail Merge: 

 
A standard File Open dialog will appear prompting you for the 
MS Word main document template – only the .dot files will be 
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listed (Refer to “Creating the Main Document Template” on page 
66 if you need more information about that template.): 

 
6. Navigate through your folders and find and select your main 

document template and then click Open. MS Word creates 3 new 
documents:  

• A document which is the same as your mail-merge 
template (with the same name, just the file name 
extension is changed to .doc). 

• A mail merge main document named 
“Document2.doc.” You use this document if you want 
to merge your letters to email instead of printing them. 
(For details, refer to MS Word online help.) 

• The merged output document named “Form 
Letters1.doc.” This document contains your customized 
letters and is ready to print out. 

 
Performing Mail Merge from the Account screen 
1. Access the Account screen. (Navigation Pane > Work > 

Contacts) 
2. In the Contact General tab, perform a search to find the contacts 

you want to send letters to. Make sure your search criteria define 
the desired recipients as closely as possible. (For details on how 
to perform the search, refer to “Finding Contacts” on page 29.) 
The found matches will be displayed in the Results Panel in 
bottom area of the screen: 
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3. (Optional) Sort or group the records as necessary. (For details, 

refer to “Sorting and Grouping Records” on page 20.) 
4. Further, the procedure is the same as described in the previous 

topic, “Performing Mail Merge from the Contact Groups Screen”, 
steps 4÷6. 

 

Unlocking the Full Version 
To switch from the time-limited demo version of INSIDER® to the 
full unrestricted version of the program you need first to purchase 
INSIDER® and obtain a license file from either your INSIDER® 
dealer/consultant or directly from IRM (www.insider.bg). Once you 
have the license file, do the following to unlock your INSIDER® 
installation: 
1. From the Help menu, select License…: 

http://www.insider.bg/�
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This will display the License pop-up window for entering the 
license file into the program: 

 
2. In the field, enter the full path and filename of the license file. 

(Use the Browse button to navigate to the file location and to 
select the file.) 

3. Once the path and name of the license file are properly entered 
into the field, click OK. Your INSIDER® should be now 
properly licensed and unlocked. 

 

Deleting the Sample Data 
Once you are about begin your real use of INSIDER®, you will need 
to delete the sample data with which the INSIDER® demo comes and 
any test data you might have entered while initially trying the 
program. To do so, in any screen, click and select the record you want 
to delete (or multiple records, for that matter) and after that, right-click 
on it and, from the right-click menu, select Delete or Delete Selected 
depending on which option is available in the current context. 
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